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S32 Design Studio for ARM 2018.R1 

 

1. Release description 

NXP Semiconductors is pleased to announce the release 

of the S32 Design Studio for ARM 2018.R1 for 

Automotive and Ultra-Reliable MCUs. The S32 Design 

Studio is based on the Eclipse open development 

platform and integrates the Eclipse IDE, GNU Compiler 

Collection (GCC), GNU Debugger (GDB), and other 

open-source software to offer designers a 

straightforward development tool with no code-size 

limitations. 

1.1. Release content 

• Eclipse Neon 4.6 Framework 

• GNU Tools for ARM® Embedded Processors 

(Launchpad) build (4.9.3 20150529) 

• ARM64: Linaro GCC 4.9-2015.05 

• GNU Tools for ARM® Embedded Processors 

build (6.3.1 20170824) 

• Libraries included: newlib, newlib-nano and 

ewl2 (ewl and ewlnano).  

• GDB 7.12.1 with Python 

• P&E Multilink/Cyclone/OpenSDA  (with P&E 

GDB Server) 

• SEGGER J-Link (with SEGGER GDB Server) 

• New Project wizard to create application and 

library projects for supported devices 

• Fully integrated S32 SDK for S32K14x EAR 

release v.0.8.6. For the details on the feature set of SDK please refer to SDK Release notes and 
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Reference Manuals1 

• SDK management included: 

o Sample Drivers for KEA family (Evaluation grade) 

o FreeMaster Serial Communication driver for KEA and S32K families 

o Automotive Math and Motor Control Libraries for KEA and S32K devices2, S32V234 

device, supporting the ARM Cortex-M4 core. The AMMCLIB release 1.1.8 and 

release 1.1.11 integrated, though the particular version availability for a device could 

be limited by supported compiler versions. 

• Import projects from CodeWarrior for MCU v.10.6 and Kinetis Design Studio for respective 

supported processors 

• IAR v7.x and v8.11.2 compiler support by new project wizard3.  

• GreenHills v2017.1.4 compiler support by new project wizard4.  

• iSystem, Lauterbach and IAR debuggers support by new project wizard. 

• Kernel Aware debugging for FreeRTOS, OSEK. 

• MQX 4.2 for MAC57D54H with possibility to create project from example 

• Devices supported:  

o SKEAZN8, SKEAZN16, SKEAZN32, SKEAZN64, SKEAZ128, SKEAZ64 

o S32K144 v2.0, S32K142, S32K146, S32K148 

o S32V234 

o MAC57D54H 

2. What’s New 

2.1. New/Updated device support  

• S32K146 

 
 
 
 
1 Please note that S32K SDK has Early Access Release status, that means that there could be some limitations 
and issues. The S32K SDK is available for Windows host only. There is limitation on the supported GreenHills 
compiler version – the SDK released with GreenHills v2014.4, but due to GreenHills plugin limitation support for 
GreenHills compiler v2017.1 integrated, so new project wizard would not provide possibility to create SDK project 
with GreenHills compiler. 
2 The AMMCLIB for S32K family is provided integrated into S32K SDK for Windows host and as AMMCLIB SDK 
for both hosts. 
3 The plugins to support IAR, GreenHills, iSystem, Lauterbach are not included and have to be installed from 
corresponding update site or installation.  
4 Due to limitation of GDB debugging support for binaries built with GreenHills compiler the NPW support only 
Lauterbach debugger for such projects. 
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2.2. New Features 

• Updated Eclipse Neon 4.6 Framework (to CDT version 9.2.1) 

• GNU Tools version 6.3.1 integrated and supported by NPW for S32K1xx devices 

• Updated SEGGER and P&E debug plugins to the latest and greatest versions 

• S32 SDK for S32K14x EAR release v.0.8.6 integrated 

• AMMCLIB v.1.1.11 integrated 

• Restyled Getting started page to allow the centralized access to documentation and additional 

materials 

• MQX 4.2 for MAC57D54H with possibility to create project from example 

• Support for IAR v8.11.2 compiler by New Project Wizard for S32K family 

• Support for GreenHills v2017.1.4 compiler by New Project Wizard 

 

NOTE 

Support for new compiler versions provided with New Project Wizard to 

create projects. There is no migration support between compilers/plugins 

versions. IAR plugin provides support for both 7.x and 8.x versions, so old 

projects will be opened without problem. GreenHills plugin does not 

provide compatibility with older version, so some project settings could be 

lost. 

 

2.3. Bug Fixes  

• Updated header and register description files to fix issues and synchronize with latest Ref 

Manual versions 

• S32DS-4629  Clean rule doesn't work after particular user actions in "C/C++ Build -> 

Behavior" 

• S32DS-301  After some debugging work (using BP, Stepping, Resume...) Disassembly view 

content disappears. 

• S32DS-1093 Debugging session hangs when "c" step over is done on a loop statement that has 

its entire block in a single line. 

• S32DS-273 Can not suspend after set condition of breakpoint = 0 and resume 

• S32DS-61 Breakpoint Properties disappeared after right-click into breakpoint 

• S32DS-6072 Unable to export S32K144 SDK project into ProjectInfo.xml 
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3. System Requirements for Windows Host 

3.1. Recommended Configuration 

• PC with 2.6 GHz Intel® Pentium® compatible processor or better 

• 4 GB of RAM  

• 7 GB of disk space (when installing full product or updates) 

• 5 GB on Windows system disk  

• USB port for communications with target hardware 

• Ethernet port for communications with target hardware (optional) 

3.2. Operational Minimum Configuration 

• PC with 1.8 GHz Intel® Pentium® compatible processor 

• 2 GB of RAM  

• 7 GB of disk space (when installing full product or updates) 

• 5 GB on Windows system disk  

• USB port for communications with target hardware 

3.3. Host Operating System Support 

• Microsoft Windows 7 32-bit and 64-bit  

• Microsoft Windows 8/8.1 32-bit and 64-bit 

• Microsoft Windows 10 32-bit and 64-bit  

S32 Design Studio for ARM 2018.R1 supports all editions of the operating systems listed above and is 

limited only by the requirements of the Java Runtime Environment. 

4. System Requirements for Linux Host 

4.1. Recommended Configuration 

• PC with 2.6 GHz Intel® Pentium® compatible processor or better 

• 4 GB of RAM  

• 6.7 GB of disk space (when installing full product or updates) 

• 4.8 GB in /tmp directory  

• Java 1.8 

• USB port for communications with target hardware 

• Ethernet port for communications with target hardware (optional) 
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4.2. Operational Minimum Configuration 

• PC with 1.8 GHz Intel® Pentium® compatible processor 

• 2 GB of RAM  

• 6.7 GB of disk space (when installing full product or updates) 

• 4.8 GB in /tmp directory   

• Java 1.8 

• USB port for communications with target hardware 

4.3. Host Operating System Support 

• Ubuntu 14.04  64-bit 

• Debian 8  64-bit 

• CentOS 7  64-bit 

The plugins to support 3rd party compilers or debuggers might not be available for all host versions 

supported by S32 Design Studio, the information should be checked with corresponding vendor. 

5. Product WEB page 

S32 Design Studio for ARM 2018.R1 product page is http://www.nxp.com/S32DS. It contains general 

information about this product, updates, and download links. 

6. Installation and Licensing 

The installer package contains the complete S32 Design Studio for ARM 2018.R1 suite and an installer. 

All data needed by the installer will be downloaded and no other download will be performed5. Run the 

installation package and a wizard will guide you through the installation process.   

During installation the license activation will be requested. The following types of activation are 

supported: 

• Online activation, requires the internet access and request for license will be sent to license 

server automatically. 

• Offline activation, no internet access required, the offline activation request is generated and 

should be uploaded to licensing site to get the activation response, which should be loaded back to 

installer. 

 

 
 
 
 
5 The plugins to support 3rd party compilers or debuggers are not included and have to be installed from 
corresponding update site or installation 

http://www.nxp.com/S32DS
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New functionality including support for new devices can be added to S32 Design Studio for ARM 

2018.R1 with service packs, updates and patches. Service packs add specific support for new devices. 

Updates and patches correct software defects and add general functionality affecting more than one 

device family.  

 

New support can be added directly from the internet or from a downloaded archive. If your computer is 

connected to the Internet, select Install New Software in the Help Menu and all available updates will be 

displayed. If your computer does not have Internet access, you can download the archive that contains 

the service pack, update or patch you need from product page and use Install New Software in the Help 

Menu pointing to this downloaded archive.  

7. Technical Support 

S32 Design Studio issues are tracked through the S32DS Public NXP Community space: 

https://community.nxp.com/community/s32/s32ds . 

 

For confidential cases and cases which cannot be publicly shared on NXP Community please follow the 

steps described here: 

https://community.nxp.com/docs/DOC-329745 

 

 

 

https://community.nxp.com/community/s32/s32ds
https://community.nxp.com/docs/DOC-329745
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Appendix A. Known issues and Workarounds 

  

• Conditional watchpoints and breakpoints: Conditional breakpoints and watchpoints, including 

those using ignore counts, do not always work. 

Workaround:  Do not use conditions for breakpoints and watchpoints, instead check for 

condition in the code and set a normal breakpoint. 

• Uninstallation of P&E drivers: The P&E Device Drivers item will remain in the Control Panel/ 

Programs and Features after uninstallation of S32 Design Studio, if user will try to use this item 

to uninstall – error message appeared, the user should ignore it. But the drivers will remain in the 

system. 

Workaround: P&E drivers should be uninstalled before the product uninstallation. But one 

should be careful if several products are using P&E drivers. 

• Disassembly view  content might be destroyed occasionally.  

Workaround: Close disassembly view and open it again using menu  Window → Show View 

→ Disassembly. 

• USB driver conflict between P&E and Xilinx software: P&E Drivers for Windows utilize the 

3rd party service Jungo WinDriver to enable USB support under windows XP/7/8.x/10. Xilinx 

also uses WinDriver for their driver packages, but older versions. Starting with the P&E Driver 

package 11.7, a conflict between P&E Drivers and software IDES that rely on older Jungo driver 

packages might occur. This is because both the old and new driver packages utilize the same .sys 

file (windrvr6.sys). When the new P&E Drivers are installed, Xilinx tools stop working after 30 

days because the new sys file requires a new license that the older Xilinx software does not have. 

Workaround: Please follow the steps in P&E's FAQ 255 for installing an older version of P&E 

Drivers (11.1) to resolve Xilinx conflict under Windows XP/7/8.x. 

http://www.pemicro.com/website_management/faq_view.cfm?id=225   

If drivers issue persists, please submit a support request to P&E Microcomputer Systems: 

http://www.pemicro.com/support/index.cfm   

• Missing license could be reported on IDE start. 

Workaround: Same activation ID should be entered. 

• Problems could be experienced while debugging of elf file generated by GHS compiler like 

missing call stack information, incorrect info on step into function, etc. 

Workaround: On occasion GHS generates GDB incompatible debug information preventing the 

debugger from displaying the call stack. In some cases, without such information gdb can still 

debug your program. The program build needs to be augmented with a post-build step, select the 

project in the project explorer view and File->Properties to display the project properties, under 

C/C++ Build -> Settings select the build steps tab and enter the command gstrip –

r=.debug_frame executable. Switch to Instruction Stepping Mode to be able to step through 

function.  If this workaround does not help – please report issue to GreenHills support. 

• Linker error might be reported for devices with small RAM (for example KEAZN16) if the 

project is created from NPW (C++ and EWL) and later "Library" option changed to 

"newlib"/"newlib_nano"  

Workaround: The linker file should be modified to delete/comment the following symbol 

http://www.pemicro.com/website_management/faq_view.cfm?id=225
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definition EXTERN(ZN10cxxabiv119_terminate_handlerE) 

• SDK attach mechanism could report error about missing files if more than one SDK attached 

and they might have conflicting files. 

• For project with IAR toolchain the error reported if the "Properties" console is active and the 

user selects "NXP S32K144" in Project Explorer.  

Workaround: Do not select "NXP S32K144" in Project Explorer, it is IAR plugin issue.  

• Hyperlinks might not work correctly under Windows 10 when Microsoft Edge is default 

browser 

Workaround: Set another browser as default. 

• Welcome page might be seen as empty under Linix  

Workaround: Webkit1 for GTK2 needs to be installed with the following command sudo apt-

get install libwebkitgtk-1.0-0 

  

 

NOTE 

There are some issues which are introduced by CDT therefore reproduced 

in S32 Design Studio. Those issues might be fixed when the fix is 

available with newer CDT version and when S32 Design Studio migrates 

to it.  

 

Appendix B. Performance Considerations 

The following suggestions will help keep the S32 Design Studio tools running at a respectable 

performance level. 

1. To maximize performance, the S32 Design Studio tools should be installed on a computer with 

the recommended system configuration. While the tools will operate on a computer with the 

minimum configuration, the limited hardware will restrict its ability to function at desired 

performance levels. 

2. Close unused projects. Eclipse caches files for all open projects in the workspace. If you need 

multiple projects open, try to limit the number of projects to no more than 10. 

3. The Eclipse IDE provides several options that provide user assistance tools. These options, 

however, use memory and cpu bandwidth. If performance is slow and you do not need these 

options, turn them off.  

• Scalability options configure how eclipse deals with large source files. 

— Scalability options: 

– Editor live parsing: impacts parsing while typing, Outline View, semantic highlighting, 

folding, etc. 

– Semantic highlighting: C/C++ identifiers are colored 

– Syntax coloring: coloring of keywords, comments and literals 
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– Parsing–based content assist proposals: content assist proposals which require parsing 

the file  

– Content assist auto activation: content assist activated automatically on trigger 

sequences, like '.', '::' or '–>'. 

— To disable 

– Click menu ‘Window’ –> ‘Preference’  

– Expand ‘C/C++’ –> ‘Editor’ –> ‘Scalability’ 

– Uncheck ‘Enable all scalability mode options’ 

• Content Assist Auto Activation can reduce the number of keystrokes a developer must type to 

create code. The Content Assist plug-in consists of components that predict what a developer 

will type, based on the current context, scope and prefix. 

— To disable: 

– Click menu ‘Window’ –> ‘Preference’  

– Expand ‘C/C++’ –> ‘Editor’ –> ‘Content Assist’ 

– Uncheck all the options for ‘Auto-Activation’  
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